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1. Welcome to Graitec Powerpack for Revit 2024 
We are delighted to inform you that GRAITEC has released an updated version of PowerPack for Revit. 
This latest update incorporates a host of new features and improvements, with a special focus on tools 
designed to simplify the creation of the analytical model. In addition to these new features, the update 
also includes a range of bug fixes that were previously impacting some geographic regions. We aim to 
continually enhance the functionality and usability of PowerPack for Revit, and we are confident that 
this latest update will prove to be a valuable addition to our users. 
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2. General 

2.1. Powerpack names 

We are thrilled to announce that we have rebranded our popular Powerpack products to better reflect 
their features and functionality. The rebranding involves four Powerpack versions: 

• Powerpack Standard is now Powerpack Start Edition, providing users with essential tools to 
initiate their Revit journey. 

• Powerpack Professional has been renamed as Powerpack for Revit, offering advanced features 
and functionality for experienced Revit users. 

• Powerpack Premium Concrete is now PowerPack for Revit Rebar Detailing providing an all-in-
one solution for Revit users who need to detail rebar structures. 

Powerpack Premium Concrete with concrete design extension is now PowerPack for Revit Rebar 
Design + Detailing delivering a complete solution for Revit users who need to design and detail 
rebar structures. 

With this rebranding, our users will have a clear understanding of the capabilities of each Powerpack 
edition and can easily choose the one that best suits their needs. We are confident that our new 
branding will help us to continue providing the highest quality Revit add-ons to our users. 

2.2. Update all Graitec libraries  

As the PowerPack 2024 is only compatible with Revit 2024, all content provided with the PowerPack 
has been updated to the current version of Revit.  

This means that every library, template, and content such as Rebar Schedules Template, Legends 
dimension, and Graitec’s families have been updated. This update will result in much better-performing 
software since automatic updates are not performed anymore when loading those elements.  

 

Libraries update 
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2.3. Dark Theme 

The user interface of our Powerpack for Revit is now compatible with the new Dark Theme of Revit 
2024. This means that you can apply the new color scheme to both Revit and the Powerpack through 
the Options Menu. To make changes to the theme settings, simply follow these steps: 

• Click on the File tab, then select Options and choose the Colors tab. 
• Under the UI active theme option, you can select the Dark Theme (1). 
• To set the drawing area theme to either Light or Dark, go to the Canvas color scheme option 

on the same tab (2). 
By following these steps, you can easily customize the appearance of Revit and the Powerpack to best 
suit your preferences. 
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Dark theme 
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2.4. Enter to activate the last tool used 

This behavior is present for all Revit tools. Now it is available in our Powerpack, users can Press 
<ENTER> to activate the last tool used. 

The user doesn’t have to right-click and click on Repeat like in older versions. 

 

 

Press <ENTER> to activate the last tool used 
 
 
 

3. PowerPack Start Edition 

3.1. Quick Dimension for MEP objects and Generic Models 

Our Quick Dimension tool now supports MEP elements and Generic Models such as slab openings, 
allowing for easier and more accurate dimensioning in the MEP design process. 

 

Quick dimension setting interface 
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Example for generic models 
 

3.2. Family Manager: Overwrite loaded families 

The Family Manager has the possibility to overwrite loaded families. When modifications are made to 
a family the Family Manager will now give you the option to re-load and overwrite the pre-loaded 
family.  The options are identical to when you load an edited family from the family editor. 

 

 

3.3. Web Stiffeners 

Users can now add stiffeners to W-beams or I-beams with the added functionality to customize 
various parameters such as spacing, offset, insertion location, insertion side, and stiffener size. 

The tool is available in the Powerpack Ribbon => Structural => Web Stiffeners 
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After clicking Web Stiffener, select a W-beam or I-beam to add stiffeners to. The user is presented 
with the following interface: 

 

Web stiffener setting interface 
 

Select spacing, offsets, insertion location, insertion side, and stiffener sizes. 

1. Spacing: Adjust the spacing between stiffeners 
2. Edge offset: Shrink or extend stiffeners 
3. Top/Bottom offset: Add a stiffener offset from top/bottom of flange 
4. Insertion Location: Only web center is available 
5. Insertion Side: there, you can choose which side of the beam to add stiffeners: 

▪ Side 1: determined by the direction in which the element is modelled 
▪ Side 2: determined by the direction in which the element is modelled 
▪ Both: Stiffener added to both sides. 
▪ Both staggered: Stiffeners will be placed on alternating side of the web based on spacing 

and click on select by range before selecting point on stiffener. 
6. Select By Points/Range:  

• Select by points: select points on the beam to place stiffeners. 
• Select by range: select the beginning and the end of stiffeners you want to place, and they 

will be placed and adjusted according to spacing. 

The web stiffeners that are added to the beams belong to the "Generic Model" category. To view them 
in the model, the "Generic Model" category needs to be enabled in the Visibility/Graphics settings of 
the view. 
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Web stiffeners only place in a 3D view but can be positioned or moved in a 2D view afterward. 

 

Add stiffeners in 3D views 
 

 

 

Add stiffeners to side ½ based on the beam’s orientation 
 

Important: Make sure that the selected beam’s family has parameters:  k2 and Web fillet values. 

 

Beam's structural geometry 
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Otherwise, you will get an error message telling the user that there are missing values. 

 

Error message if k2 and Web fillet values are not defined 
 

Also, the generated stiffeners are Generic Models and do not shrink or extend if you change the beams 
type or family. Users will need to redo the command if they modify the beam. 

 

3.4. Cope beams/columns 

Revit has a coping tool that aids in the presentation of detail views by applying a cope to intersecting 
members. However, the default coping tool only handles one coping cut at a time. In cases where 
multiple elements require coping, the process becomes time-consuming. 

Our new tool "Cope" has been developed to overcome this limitation. With this tool, users can 
automatically cope a beam/column with any intersecting beams or cope all intersecting 
beams/columns with a selected beam/column and apply an offset or remove all coping. This tool 
enables more efficient and accurate coping of beam/column connections compared to the default 
coping tool. One of the key advantages of this tool is its speed and precision. 

The tool is available in the Powerpack Ribbon => Structural => Cope and has three (3) options:  

- To apply coping to a beam, select the beam and then click on the "Cope by intersecting 
beams/columns" command from the menu. 

- To apply coping to multiple beams, select a common intersecting beam and click on the "Cope 
all intersecting beams/columns" command.  

- To remove all coping for a beam/column select the beam/column and execute the remove all 
copings. To remove all coping for many beams/columns, select the common intersecting 
beam/column and run the same command. 
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To use this command, the user needs to:  

1. Select a beam or column. 
2. Chose which function you want to apply. 

                      

How to use the command "Cope beams/columns" 
 

Coping offsets (notching distance) can be set within the built-in app or modified after the Revit 
Properties palette.  

 

Notching distance 
                

Notes: Revit has a specific tolerance level for coped beams that are less than 1 meter in length, which 
means that these beams will not be visible in the model.  

3.5. Split columns 

Splitting columns provides you with greater flexibility in terms of modelling different types of 
structures. Users can split one or multiple structural or architectural columns with the new command 
“Split Columns”. There are three (3) ways of doing this.  
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- Splitting by point: 
Launch the command, then select the columns to split (1). After that click on the element on the 
points where you want the columns to be split and click on Finish (2). Get your columns split (3). 
 

     
 

- Splitting by level:  
Launch the command, then select the columns to split (1). After that select levels where you 
want the columns to be split and click on Finish (2). Get your columns split (3). 
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- Splitting by reference plane:  
Launch the command, then select the columns to split (1). After that select reference planes 
already placed where you want the columns to be split and click on Finish (2). Get your columns 
split (3). 
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4. PowerPack for Revit  

4.1. Element lookup UI enhancement 

We have simplified the user interface of the "Element Lookup" command to enhance the user 
experience by making search more intuitive and by adding new options to it. 

Override is a new option that helps users to highlight, with a color, searched element in their current 
workspace. You must click Select before overriding the elements. 
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Footing elements override color with green 
        

 

4.2. Create Analytical Model on selection 

4.2.1. Functionality 

Revit provides the functionality to generate an analytical model from an existing physical model that 
has already been created. Although this process involves using Dynamo scripts, it’s taking time and 
requires several clicks and opening of windows. To address this issue, we have introduced a new 
command that enables the quick creation of an analytical model upon selection.  

This command is now included in Powerpack for Revit 2023.1.1. 

 

4.2.2. How to use the command 

The tool is available in the Powerpack Ribbon => Structural => Create Analytical Model 

  

Command “Create Analytical Model” in Powerpack Ribbon 
 

This tool is designed to generate analytical elements based on a selection of structural elements. To 
initiate the process, the user needs to click on the "Create Analytical Model" command and select the 
structural elements to be transformed into an analytical model. The tool will generate analytical 
members, panels, and openings for the selected structural elements. There are two different methods 
available for using this tool. 
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• Method 1: Selecting elements => Click on “Create Analytical Model” command 

       

 

• Method 2: Click on “Create Analytical Model” command => Selecting elements => Click on 
“Finish” 
 

                                

 
 

The analytical model will be generated automatically using one of the two methods. The result is an 
unconnected model on which users will have to make some modifications to connect the model using 
the Align option and others. 

 

4.2.3. Benefits 

This tool speeds up the process of creating an analytical model compared to the native Revit method 
by using Dynamo script in Revit. Our tool is 2 times faster than the Revit method. See the comparison 
below. 
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Duration of the process using Revit “Analytical Automation” 
 

 

Duration of the process using PowerPack “Create Analytical Model” 
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4.3. Automate Analytical Model  

4.3.1. Functionality  

Graitec has developed a suite of tools aimed at simplifying the creation of analytical models for 
engineers using Revit. Some of these features were available in the Powerpack for Revit 2023.1.1, while 
others will be included in the upcoming major release, Powerpack for Revit 2024.  

By using these tools, the process of generating analytical models from physical models is automated, 
resulting in a smoother and more efficient experience. Each tool incorporates unique features, 
including automated addition and linking of analytical elements to newly created structural elements, 
while preserving their physical characteristics.  

These tools provide our users with a comprehensive set of features for the creation of analytical 
models, and we are excited to continue enhancing and expanding our offerings in future releases. 

4.3.2. How to use the command 

The tool is available in the Powerpack Ribbon => Structural => Automate Analytical Model 

 

 
The button highlighted means that the command is activated.  

 

Command activation 
               

Once the command is activated, all the information of newly created physical elements will 
automatically be updated to their analytical elements. Furthermore, any changes made to the physical 
model will automatically update the analytical model:  

• Creating structural elements 
• Moving structural elements 
• Adding openings 
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Information on the analytical elements is automatically updated 

 
This method of creating analytical members and panels is different from using Revit's "structural 
analytical model" tools, as it eliminates the need for users to redefine the material or structural role. By 
doing so, it saves time, and is user-friendly, while also reducing the likelihood of errors. 

While the command is active, all the structural elements that are created will be added to the 
analytical model. To prevent any further addition, the user needs to deactivate the command by 
clicking on "Automate Analytical Model." The highlighted button indicates that the command is 
currently activated.   

                                  

Disactivate the command 
 
 

4.4. Analytical Assumptions 

When utilizing the "Create Analytical Model" command, the geometric properties and material 
specifications are retained, and the analytical model is linked to its corresponding structural model. 
Nevertheless, it does not update automatically with the structural model. This means that changes 
made to one model will not automatically reflect in the other. Similarly, elements added after executing 
the command will not be automatically included in the analytical model. 

It is important to note that when the "Automate Analytical Model" command is active, all elements 
created during this period are interconnected  
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4.4.1. Walls 

Walls created by both commands are converted to an analytical panel at the axis/centreline of the 
wall.  

 

 

Walls assumption 
 
 

4.4.2. Curved Walls 

Curved walls are currently not supported. 

 

Curved walls assumption 
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4.4.3. Beams 

Beams are converted to an analytical member according to the “z justification” point chosen at the 
level where they are placed. Users can change the “z justification of the beam”. 

 

Beams assumption 
 

4.4.4. Columns 

Columns are converted automatically to an analytical member at the level where they are placed. The 
analytical member is at the center of the element. 

 

 

Columns assumption 
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4.4.5. Slabs/floors 

Slabs/floors are converted automatically to an analytical panel at the level where they are placed.  

       

 

Slabs assumption 
 
 

4.4.6. Footings 

Footings are not supported by these commands. Users need to set them through the Revit boundary 
conditions tools. 

 

Footings assumption                    
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4.4.7. Openings 

4.4.7.1. Using “Create Analytical Model” 

All openings in the physical model are realized when using this command. By face, shaft, wall, vertical, 
family openings, windows, and door openings are all supported.   

 

Openings are supported using “Create Analytical Model” 
                               

4.4.7.2. Using “Automate Analytical Model” 

Adding openings (By face, shaft, wall, vertical, windows, and door openings) to the physical model is 
updated automatically on the analytical model. 

 

Openings are supported using “Automate Analytical Model” 
                          

4.4.7.3. Exporting 

It is important to note that openings are default. They cannot be deleted when exporting to the 
modules as in the old versions. 
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4.5. Trim or Extend 

4.5.1. Functionality 

‘Trim or Extend’ is a new tool that helps when creating analytical models in Revit. With this tool, users 
can adjust analytical models to match the target analytical model by trimming or extending them. In 
Revit you can use the Align tool, but only for perpendicular analytical elements. There is no tool in Revit 
for adjusting analytical models, so using Trim or Extend eliminates the need for a manual displacement 
of nodes.  

4.5.2. How to use the command 

The tool is available in the Powerpack Ribbon => Structural => Trim or Extend 

 

Step 1: After selecting this command, a user needs to select elements to trim or extend.  Users can 
select multiple elements to Trim and Extend at the same time and click on “Finish”. 

Step 2: Then the user must select the reference element which should be the boundary. 
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How to use “Trim or Extend” 
      

Notes: 

If “Trim or Extend” command doesn’t function, please check distance tolerance as follows: 

You can manage the distance tolerances for both the Trim or Extend options in the Structural settings 
Panel. 

 

 

Trim or Extend setting interface 
 

 

4.6. Magnetize 

4.6.1. Functionality 

Using the "Align" option of Revit on analytical models especially surfaces doesn’t work well. The 
command ‘Magnetize’ helps to align analytical elements to a grid, allowing the user to correct any 
flaws in the model by ensuring that objects are properly aligned.  
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4.6.2. How to use the command 

The tool is available in the Powerpack Ribbon => Structural => Magnetize 

 

 

1. After clicking on the command, the user has to select the elements the user wants to magnetize. 
Users can magnetize multiple elements at once. 

2. Then, the user must select the grid to which the user wants the elements to be aligned. 

              

     

 

How to use command "Magnetize" 
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Notes: 

The function “Magnetize” applies to all types of structural elements, structural walls, beams, and 
columns. 

 

 

4.7. Formwork Area for stairs 

To ensure that the stairs are constructed safely, accurately, and with the desired shape and size, 
Formwork Area is now available for stairs on Powerpack. The calculation considers all the faces of 
the element minus the horizontal faces at the top side. 

 

 

The stairs’ formwork area is calculated 
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4.8. Navisworks Clash: Interacting with the view 

Users now have the ability to actively engage with the view. With this feature, you can actually play 
around with the view to get a better look at the clash. It lets you zoom in and out and move around so 
you can really see what's going on. By having this hands-on approach, it's easier to catch any problems 
and fix them quickly, which saves time and makes things smoother. 

 
Navisworks Clash import 

 
 

                 
Clashes are illustrated and encircled in red 
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5. PowerPack for Revit + Rebar Design & Detailing 

5.1. Ribbon customization 

In Ribbon customization dialog in PowerPack ribbon, Detailing and Design now get their ribbons. With 
the possibility to enable or disable ribbons panels and each command. 

 

 

Ribbon customization 
 

5.2. Assign Rebar Roles 

5.2.1. Functionality 

“Assign Rebar Roles” is a new command in Powerpack Detailing to assign specific rebar roles to 
already reinforced elements in Revit. That will help the user in the process to check any rebar cage 
made in the model. 
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Users can assign multiple roles to the bars that are in the model with our Generic roles that cover a lot 
of roles. 

5.2.2. How to use the command 

After clicking the command, users can choose ‘Rebar Role’ (1) and click Assign Role tab (2). Then users 
can select the element they wish to assign it to (3) and click the Finish tab (4). The Rebar role 
information is now available in properties. (5). 

 

Rebar role definition 
 

 

How to use command “Assign Rebar Role” 
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But users can create their own custom rebar roles. For that, they need to click on the "+"  in the Custom 
Roles group. Once the user adds a custom role,  he can rename it to define the role. Custom roles can 
also be duplicated by clicking on the “+”. 

 

Add custom rebar roles 
 
 
 

5.3. Clone Drawings 

To enhance the efficiency of drawing creation, we have introduced a feature that enables quick 
multiplication of drawings. This functionality will find a link between views and structural elements, 
then it will automatically assign roles to existing rebars based on their shape and position relative to 
the element, then it will find and organize all annotation elements that are dependent on the element 
or to the rebar hosted by the element.  

With all this information the tool will recreate the views and the annotation elements to a new element 
of the same category regardless of its different shape or hosted rebar cage by finding similarities 
between the template element and the target elements. 

The tool is designed to work in a “many-to-many” relationship between elements, which means that 
the user can clone drawings between multi-span beams or multi-level columns.  

By using the clone drawings feature, a substantial amount of time is saved during the process of 
creating drawings for structural elements, as it automatically generates near-completion drawings 
that would otherwise need to be created manually. 

The button is present in the Detailing Ribbon and Design Ribbon. 
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5.3.1 Assumptions 

For a view to be linked to the element, the view needs to contain at least one of the following: 

- Tag on the element 
- Tag on a rebar hosted by the element 
- Multi-rebar annotation on a rebar hosted by the element 
- Bending detail (from Powerpack or from Revit) 

 

 

Examples of views that will be linked to element 
 

For a view to be linked to a group of éléments (multi-span beams or multi-level columns), all elements 
need to follow one of the rules already specified. 

 

Example of a view that will be linked to a group of elements 
  

After linking the views to the element, the tool will automatically assign roles to the rebars hosted by 
the element based on their shape and position relative to the element.  

 

Example of automatically assigned rebar roles 
 

After assigning the roles, the tool will search for all annotation elements (tags, MRAs, dimensions, 
bending details) placed on the views and will correlate them with rebars based on their rebar role. 
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Examples of final drawing that can be cloned 
 

 

 

 

Any type of 2D view will be cloned regardless of its position or rotation relative to the template/target 
elements. 

Supported categories are:  

- Structural Framing 
- Structural Column 
- Structural Foundation 
- Walls 
- Floors 

5.3.2. Adjusting annotation elements 

As mentioned before the tool will deliver spectacular results even for elements that have a different 
shape or elements that host a different rebar cage. 

This is because we developed algorithms that adjust the position of tags, MRAs, and Bending details 
to the shape of the new element. 

Also, plenty of dimension references will be correlated and reproduced between the template and the 
target elements. 

NOTE: For independent elements, only rebars hosted by the element will be detailed regardless if they 
are visible or not. For groups, all rebars hosted by the elements inside the group will be detailed. 

 

Examples of annotation elements successfully adjusted to a target element with considerable 
differences 
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5.3.3 Running the tool 

After running the tool, the user needs to select the template element. If the element is detailed in view 
as part of a group, as mentioned before, the whole group will be selected. The template element/group 
will be highlighted and will not be available for selection as a target element. If there is no view linked 
to the template element, a warning will appear. 

After selecting the template element, the user can select other elements of the same category.  

If the user selects multiple target elements, those elements will be also grouped based on grouping 
algorithms.  

 
 
 

Highlight of the template group and selection of target elements 
 

After the selection is made, a dialog will appear where the user will find a list of all the views linked to 
the template element/group. He will be able to choose what views will be cloned. Additionally, the user 
will be able to choose the specific elements he wants to incorporate into his drawings like tags, 
dimensions, MRAs, or bending details. According to his options, the preview will be updated so the user 
will get a live representation of the future to-be drawing. 

 

 

Clone drawings dialog 
 

As a result, the linked views of the template element are cloned on the target elements, providing users 
with a cohesive and streamlined visual representation of their drawings. 
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5.3.4 Results 

 

Results for column transversal section. Template view on the left 
 

 
Results for multi-span beam elevation. Template view on the upper side 

 

 
Results for structural plans associated with different levels. Template view on the right 
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5.3.5 Tips&Tricks for best results 

- The tool is cloning annotation elements based on the rebar's role. Thus, all rebars with the same 
role will be detailed the same. For more specific detailing, the user can assign more rebar roles. 
The rebar roles will be preserved upon using rebar propagation 

- All plans/views will be cloned. For the best runtime, always check the list of linked views so the 
tool will not clone unnecessary views (Plans especially will take a longer time to clone) 

- Dimensions will be best cloned if their references are placed to the faces of elements and not 
references of hosted elements (Example: Walls that are hosting door/windows. Check the 
references when placing the dimensions) 

- Dimensions will keep account also for nested families 
 

5.3.6 Known limitations 

- Currently, groups are available only for beams and columns 
- Some dimension references will not be cloned properly (Revit limitation) 
- Currently, no symbols will be cloned 
- Grids will preserve their adjusted length and position (Revit limitation) 

 

 

5.4. Automatic Partition Numbering 

Currently, Revit allows users to automatically assign numbers to reinforcement following 
construction sequences. Each sequence is defined as a partition. Rebar numbers within the same 
partition are created based on the rebar type, shape & geometrical parameters. 

 

Reinforcement numbers window 
 

Partitions must be created or assigned manually on reinforcement elements with Revit. So, it can be 
tedious if the user needs to define several of them (e.g.: for each structural host in a big project). 
Instead, Revit leaves available the graphical programming interface “Dynamo” to do this 
automatically. This can be complex for Revit users who do not need to use it frequently. 

Our new feature called “Automatic Partition” makes this process automatic in Revit and is now 
available. Users get rebar partitions for each structural element selected. 
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Automatic partition in Powerpack 
 
 
 
 

 

Reinforcement numbers with partitions made 
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Rebars in one footing foundation are automatically assigned to one partition  
 

 

Using this tool also automatically resets the rebar number of each structural element selected.      

 

Results users will get 
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5.6. Main Bars for Beams: UI enhancement 

To simplify the process of reinforcing beams using "Main Bars," we have implemented certain 
improvements to the user interface. The Transversal Bars window has been enhanced, which enables 
easier reinforcement of the beams. 

 

Transversal Bars’ setting interface 
 

Users can define the distribution by: 

▪ Quantity 
▪ Quantity and Length 
▪ Spacing 
▪ Spacing and Length 

And users can choose a distribution type:  

▪ Custom 
▪ 3 Zones Distribution 
▪ 2 Zones Distribution (to right) 
▪ 2 Zones Distribution (to left) 
▪ Uniform Distribution 

 
 

 
New distribution types 
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5.7. Fabrics cut for door openings when using Calculate or Constructive 
Dispositions 

Sometimes when reinforcing walls using the “Calculate” or “Constructive Dispositions” tools, the 
fabrics could cover door openings. 

Powerpack for Revit 2024 enables fabrics generated through these functionalities to be expertly cut 
to accommodate door openings. 

                  

 

Fabrics cut are now considered when using “Calculate” or “Constructive Dispositions” 
 

5.8. Fabric schema - Warning message if fabric images are not generated 

When using the tool Fabric Schema, fabric images cannot be generated if they were placed with Revit, 
and not with Calculate, Constructive Dispositions, Main Bars, Edit Slab Rebars, etc.  

 

The user is now informed if the images are not generated and there is an explanation. 

 

Warning message if fabric images are not generated 
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5.9. Setting the rebar distribution to maximum spacing for slabs 

After generating the rebar zone for a slab, all the distributions are now set to “Maximum Spacing” 
distribution type will allow the user to improve his rebar cages easily if it is needed. 

                                 

  

Distributions are now set to “Maximum spacing” 
 

5.10. Warning message for no rebar types in the project 

When using the Detailing tools, users will receive a warning message if there are no rebar types loaded 
in the project. 

 

Warning message for no rebar types in the project 
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5.11. Split bars - Keep spacing of the initial rebar set after split 

An additional feature has been introduced that allows for maintaining the distance between bars when 
selecting shift rebars. This feature ensures that the original spacing of the rebars is preserved and 
prevents the occurrence of decimal values when splitting the rebar. Moreover, it facilitates 
constructors to adhere to a rounded number for spacing. 

 

Option "Keep spacing between bars" is now possible 
 

 

As we can see in the following pictures, once the ‘Keep spacing between bars’ option is checked, the 
spacing of rebars remains unchanged. 

 

 

Rebars original spacing is kept after checking this option 
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5.12. Read the material from the Revit Rebar 

Our Powerpack can read the material (steel yield strength ) from the Revit native Rebar Bar families. 

 

Users can read Yield strength now 
 

A warning message will appear when reinforcements are made with materials that have different 
physical properties. 

 

Warning message 


